Creating and Using Signatures on Outlook Express, Windows Mail, and
early versions of Windows Live Mail
Creating a simple Text Signature in Outlook Express, Windows Mail: or earlier versions of
Windows Live Mail
1. Open the respective mail program and go to Tools/Options/Signatures tab.
2. Under Signatures, click New.
3. “Signature #1 appears. Click on Rename, and give a descriptive name to the signature
you are going to create.
4. Now in the Edit Signature box, type what you want the signature to be, such as Jim, or
Stay Well, Jim. Just like a word processor, you can jump to a new line by using the
ENTER key. So the signature can look like:
James F. Dupré
2151 Imperial Circle
Naples, FL 34110
(239) 513‐0723
5. Finally click “Apply. Now the signature will be available to “Insert”. Or you can have
every e‐mail include that signature by going back to Tools/Options/Signatures tab, but
this time putting a check in “Add signatures to all outgoing messages”. You must also
choose (if more than one) which signature to “set as default”.
Remember, although “signatures” imply a sign off, a signature can actually be anything you
wish to be able to insert, such as the starting phrase to all e‐mails, etc.
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Creating a more attractive Signature in Outlook Express, Windows Mail or early versions of
Windows Live Mail:
1. First you must create a Signature File. Open Create (or New) Mail (just as if you were
going to write an e‐mail, but do not bother to fill out address, or subject). Click in the
text area
2. Create your signature. Type the text you want.
3. Next highlight the text. Now play with Font, bold/italics, color, and size, until you are
happy with the result.
4. Go to the File menu, and choose “Save As”.
5. When the window comes up asking where to save it, create a new folder (usually within
My Documents) called “Signatures”. Open that folder.
6. Give the signature a name.
7. Now click on the drop down arrow next to the bottom line “Save as type”, and choose
HTML (the bottom choice). Remember to click SAVE! You have now created the file you
will need to use.
8. Return to Tools/Options/Signatures tab.
9. Click on New.
10. As with a text signature, “Signature #1 appears. Click on Rename, and give it a
descriptive name for the signature you are going to establish, such as “Colorful Jim” or
“Script Signature”.
11. This time in the Edit Signature box, do not type anything. Instead, click on the radio
button “File” (instead of the dot being in Text).
12. Click on Browse, and migrate to the folder you saved the signature in (If you followed
my directions, it will be in My Documents, in a folder called Signatures). Don’t panic. I
know you do not see it. The folder looks empty.
13. If you look at the last line “Files of type”, it currently says “text”. Click the drop‐down
arrow and choose “HTML files”. Now the file should appear. If it doesn’t, now get
nervous. But don’t panic, you probably just saved it to a different folder. Just look for
it. Remember to click once on the HTML file you desire, so it is “selected” (blue).
14. Click Open. You will see the file name and path will show up in the “File” line.
15. “Apply” and the signature is complete.
Remember, the Font you chose will only appear if the other person’s computer also has that
chosen font. So to copy a phrase from Indiana Jones, “choose wisely”. The most common
reported fonts on the Windows platform are the heavy sans serif Arial Black at 93% frequency,
the cursive Comic Sans MS and display style Impact at 92% each. The same three fonts with
MAC.
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Creating a Signature in Outlook Express which contains a graphic:
(Remember to keep the graphic small):
 This is a little more complicated, so either don’t try it, or don’t get frustrated. It uses the
same steps a creating an attractive signature above, except as I describe. I will repeat
the above so you can still follow step‐by‐step.
1. First you must create a Signature File. Open Create Mail (just as if you were going to
write an e‐mail, but do not bother to fill out address, or subject). Click in the text area
2. Create your signature. Type the text you want.
3. Highlight the text and play with Font, bold/italics, color, and size, until you are satisfied.
(as above).
4. Next (and here is where it changes), insert your graphic as follows:
5. Insert your graphic in the desired position as follows:
a. My recommendation is to first create a folder within My Documents called for
example “Signatures”.
b. Now copy the graphic you wish to use into that Signatures folder. Although
steps 5a and 5b are not entirely necessary, it keeps the files together.
Otherwise, if you move the graphic of choice, the signature will no longer
work. It also makes it easier to back up your self‐created signatures.
c. Go to the Insert menu, choose “Picture”, and browse to the graphic you wish to
use. It should have already been sized appropriately using another graphic
program, even Paint. Play with positioning of the graphic using the Space,
alignment buttons (left, center, right) or Enter keys until happy with the result.
6. Go to the “Source” tab. Initially this tab may not show. To make it appear, go to the
View menu on the New Message window (not the main Outlook Express/Windows Mail
View menu) and click on “Source edit”. Now at the bottom of the message you will see
three tabs, Edit, Source, and Preview. Click Source, and all strange text appears instead
of the message and image.
7. Select the code (text) from <BODY> and through </BODY>. In other words include the
<BODY> and also </BODY>
8. Copy: Go to Edit menu | Copy (or CTRL‐C).
9. Open Notepad (Start | All Programs | Accessories | Notepad). A blank window appears.
10. Paste: Go to Edit menu | Paste (or CTRL‐V). All the text between <BODY> and </BODY>
as well as <BODY> and </BODY> will appear.
11. Save the Notepad file: Go to File | Save. Name the file “signature_name.html” (don’t
include the quotation marks). Save it in the Signatures folder (under [My] Documents)
you created above.
12. Return to the main Outlook Express/Windows Mail window, and click on:
Tools/Options/Signatures tab.
13. Click on New.
14. As with a text signature, “Signature #1 appears. Click on Rename, and give it a
descriptive name for the signature you are going to establish, such as “Colorful name”
or “Script Signature”.
15. This time in the Edit Signature box, do not type anything. Instead, click on the radio
button “File” (the dot is now in File instead of the dot being in Text).
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Creating a Signature in Outlook Express which contains a graphic – cont’d
16. Click on Browse, and navigate to the folder you saved the signature in (If you followed
my directions, it will be in [My] Documents, in a folder called Signatures). Again, don’t
panic. I know you do not see it. The folder may look empty.
17. If you look at the last line “Files of type” (Windows XP), or the box just to the right of the
“File Name” box (Windows Vista), it currently says “text”. Click the drop‐down arrow
and choose “HTML files”. Now the file should appear. If it doesn’t, now you get
nervous. But don’t panic, you probably just saved it to a different folder. Just look for
it.
18. Click Open. You will see the file name and path will show up in the “File” line.
19. “Apply” and the signature is registered and ready to use.
20. Now you are really finished. Whew!
21. Now to use the signature in Windows XP, simply start a New Message. When ready to
insert the signature, go to Insert menu | Signature and click on it.
If the graphic does not appear, first check to be sure Outlook Express or Windows Mail has
been set to send pictures with messages. Check as follows:
1. Select Tools | Options... from the menu in Outlook Express or Windows Mail.
2. Go to the Send tab.
3. Click the HTML Settings... button under Mail Sending Format.
4. Make sure Send pictures with messages is checked.
5. Click OK.
6. Click OK again.
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Creating a Signature in Windows Mail which contains a Graphic
(Much less completed to create, but more complicated to use)
(Remember to keep the graphic small):
1. First you must create a Signature File. Open Create Mail (just as if you were going to
write an e‐mail, but do not bother to fill out address, or subject). Click in the text area
2. Create your signature. Type the text you want.
3. Highlight the text and play with Font, bold/italics, color, and size, until you are satisfied.
(as above).
4. Next insert your graphic as follows:
5. Insert your graphic in the desired position as follows:
d. My recommendation is to first create a folder within My Documents called for
example “Signatures”.
e. Now copy the graphic you wish to use into that Signatures folder. Although
steps 5a and 5b are not entirely necessary, it keeps the files together.
Otherwise, if you move the graphic of choice, the signature will no longer
work. It also makes it easier to back up your self‐created signatures.
f. Go to the Insert menu, choose “Picture”, and browse to the graphic you wish to
use. It should have already been sized appropriately using another graphic
program, even Paint. Play with positioning of the graphic using the Space,
alignment buttons (left, center, right) or Enter keys until happy with the result.
6. Go to File | Save As, and navigate to the folder you are saving you signature files (and
preferably the graphics) within. Name the file, such as “signature_name” (don’t include
the quotation marks).
7. Click on the drop down arrow next to the “Save as type” box (the line below the box you
gave it a name in), and choose HTML (the bottom choice). Remember to click SAVE!
You have now created and saved the file you will need to use.
8. Return to the main Windows Mail window, and click on: Tools/Options/Signatures tab.
9. Click on New.
10. As with a text signature, “Signature #1 appears. Click on Rename, and give it a
descriptive name for the signature you are going to establish, such as “Colorful name”
or “Script Signature”.
11. This time in the Edit Signature box, do not type anything. Instead, click on the radio
button “File” (the dot is now in File instead of the dot being in Text).
12. Click on Browse, and navigate to the folder you saved the signature in (If you followed
my directions, it will be in [My] Documents, in a folder called Signatures). Again, don’t
panic. I know you do not see it. The folder may look empty.
13. If you look at the last line “Files of type” (the box just to the right of the “File Name” box
(Windows Vista), it currently says “text”. Click the drop‐down arrow and choose “HTML
files”. Now the file should appear. If it doesn’t, now you get nervous. But don’t panic,
you probably just saved it to a different folder. Just look for it.
14. Click Open. You will see the file name and path will show up in the “File” line.
15. “Apply” and the signature is registered and ready to use.
16. Now you are finished.
17. Now to use the signature in Windows Mail, simply start a New Message. When ready to
insert the signature, go to Insert menu | Signature and click on it.
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Creating a Signature in early versions of Windows Live Mail which contains a Graphic
(Remember to keep the graphic small):
 This is even more complicated than Windows Mail to create. Using the signature is the
same as Windows Mail. But again, either don’t try it, or don’t get frustrated. Except as I
describe, it uses the same steps as creating an attractive signature as described
elsewhere, but I will repeat those here for continuity.
1. First you must create a Signature File. Open New E‐mail Message (just as if you were
going to write an e‐mail, but do not bother to fill out address, or subject). Click in the
text area
2. Create the text of your signature. Type the text you want.
3. Highlight the text and play with Font, bold/italic/underlines, color, and size, until you are
satisfied with the appearance.
4. Next (and here is where it becomes more involved), insert your graphic as follows:
5. Insert your graphic in the desired position as follows:
g. My recommendation is to first create a folder within My Documents called for
example “Signatures”.
h. Now copy the graphic you wish to use into that Signatures folder. Although
steps 5a and 5b are not entirely necessary, it keeps the files together.
Otherwise, if you move the graphic of choice, the signature will no longer
work. It also makes it easier to back up your self‐created signatures.
i. Now go to the Insert menu, choose “Image/Inline” (not Photo E‐mail), and
browse to the graphic you wish to use. You should have already sized the
graphic appropriately using another graphic program, such as Paint. Play with
positioning of the graphic using the Space, alignment buttons (left, center, right)
or Enter keys again until satisfied with the resulting appearance. Understand
that positioning is limited.
6. Here is where it differs from Windows Mail. Go to File and choose “Save As”. If the File
menu doesn’t show, hit the ALT key to display the Menu bar.
7. When the window comes up asking where to save it, find the folder into which you
previously saved the graphic (if as per my suggestion above it will be a folder labeled
“Signatures” within My Documents. (Remember to open that folder so you are inside
it).
8. Give the signature a name.
9. Click on the drop down arrow next to the “Save as type” box (the line below the box
you gave it a name in), and choose HTML (the bottom choice). Remember to click SAVE!
You have now created and saved the file you will need to use.
10. Next you must go to the folder you just saved the file within. Find the file (labeled
“signature_name.htm” (or html) and right‐click on it.
11. Select “Open with” from that right‐click menu and choose Notepad.
12. When the file opens as a bunch of strange‐looking text appears, look for a line (likely
towards the top third or half) displaying <BODY>.
13. Within the area between <BODY> and </BODY>. You are looking for an entry which
reads similar to src=cid:4387F7DCB845628DF15462@jim.
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Creating a Signature in early versions of Windows Live Mail which contains a Graphic
14. Remove everything within the quotation marks, but not the quotation marks. You must
replace that contents with the specific location of your graphic AND a backward slash
followed by the graphic name ( \graphic_name.extension ). It needs to read something
like ”src=”C:\Users\Username\Documents\Signatures\named_graphic.jpg” for example.
Remember to keep it surrounded by quotation marks.
15. The easiest way to get the path is to return to your Signatures folder and find the
graphic you are using, and right‐click on it, and choose Properties.
16. On the General tab, you will see Location and showing the entire path name.
17. Click just to the right of the location. An insertion point cursor will appear there.
18. Right‐click and choose Select All. It will select the location path.
19. Now hold the CTRL key and hit “C” (CTRL‐C). This copies the path to the clipboard.
20. Return to your Notepad document, click inside the quotation marks and then using
CTRL‐V, (or Edit menu/Paste), complete the paste of the image’s path.
21. Now add to the end of the path \graphic_name.jpg (still within the quotation marks and
REMEMBER TO INCLUDE THE GRAPHIC’S EXTENSION)
22. Save the Notepad file.
23. Now return to the main Windows Live Mail window, and click on:
Tools/Options/Signatures tab (Again use the ALT key if the menu is again gone)..
24. Click on New.
25. As with a text signature, “Signature #1 appears. Click on Rename, and give it a
descriptive name for the signature you are going to establish, such as “Colorful name”
or “Script Signature”.
26. This time in the Edit Signature box, do not type anything. Instead, click on the radio
button “File” (the dot is now in File instead of the dot being in Text).
27. Click on Browse, and navigate to the folder you saved the signature in (If you followed
my directions, it will be in My Documents, in a folder called Signatures). Again, don’t
panic. I know you do not see it. The folder may look empty.
28. If you look at the last line “Files of type” (Windows XP), or the box just to the right of the
“File Name” box (Windows Vista and 7), it currently says “text”. Click the drop‐down
arrow and choose “HTML files”. Now the file should appear. If it doesn’t, now you can
get nervous. But don’t panic, you probably just saved it to a different folder. Just look
for it.
29. Click Open. You will see the file name and path will show up in the “File” line.
30. Click “Apply” and the signature is registered and ready to use.
31. Now you are really finished. Whew!
32. Now to use the signature in Windows XP, simply start a New Message. When ready to
insert the signature, go to Insert menu | Signature and click on it.
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As I explained after the Outlook Express instructions, if the graphic does not appear, first check
to be sure the Mail program has been set to send pictures with messages. Check as follows:
1. Select Tools | Options... from the menu in Outlook Express or Windows Mail.
2. Go to the Send tab.
3. Click the HTML Settings... button under Mail Sending Format.
4. Make sure Send pictures with messages is checked.
5. Click OK.
6. Click OK again.
If those settings are correct, see the next page.Be aware, Windows Mail and Windows Live Mail
standard security settings will not include either graphics or other HTML features such as web
links, or e‐mail links unless you temporarily change the security setting to allow these things.
To use the graphic signature, temporarily remove the check from “Block images and other
External HTML content” under the Download images category (remember to Apply). Add the
signature, then replace the check. Find it under the same Tools | Options, but click on the
Security tab.
Alternatively: If you do not want to repeatedly change the security settings, do it once by,
changing the security session to allow the images. Then create a blank new message without
addresses. Give the message a subject indicating the type of signature. Now save that message
(which includes the graphic signature) in the “Draft” folder. Now each time you want to use
that signature, go to the Draft folder, copy the message to that folder. Double‐click that copy
and it will open. Simply click above the signature and type your message. The signature
obviously remains at the bottom.
For a step‐by‐step screenshot walkthrough for Outlook Express, go to
http://email.about.com/od/stepbystepwalkthroughs/ss/wt121503.htm
For Windows Mail and Windows Live Mail follow this link:
http://www.timeatlas.com/email/general/create_image_signatures_in_windows_mail_or_live
_mail
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